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Laboratory work 1 

Studying of Typical Dynamic Elements of Zero and First Order 

1.1 Objective 

Study of zero- and first-order typical dynamic elements (TDEs) and their mathe-

matic description. 

Building of Simulink models of these dynamic elements and obtaining their time 

and frequency characteristics. 

Gaining command of simulation in Matlab Simulink, plotting time and frequency 

characteristics, preparing reports on the obtained results in MS Word.   

 

1.2 Mathematical description of dynamic elements (control systems) 

Dynamic behavior of any dynamic element or a control system on the whole is 

described with an ordinary differential equation (o.d.e.), transfer function (T.F.), time 

and frequency characteristics.  

An ordinary differential equation (dynamic equation) describes the output signal 

y(t) behavior in the dynamic (transient) mode. In this mode, the output signal y(t) varies 

in accordance with its own law. Under action of the reference signal x(t) and disturb-

ance D(t), an o.d.e. is written as: 
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In the steady-state mode, the output signal y(t) varies in accordance with the law 

specified in the reference (input) signal. In this mode, y(t) behavior is described with an 

algebraic equation (static equation): 
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Transfer function is the ratio of the Laplace transform of the output signal of a 

dynamic element (control system) to the Laplace transform of the input signal of the 

dynamic element (control system). It is obtained through substituting complex variable 

S
i
 of Laplace transformation instead of i-th derivative: 
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under zero initial conditions: 



 2 

)()...(

)()...()()...(

1
1

10

1
1

101
1

10

SDcScScSc

SXbSbSbSbSYaSaSaSa

kk
kk

mn
mm

nn
nn














.    (1.3) 

For the reference signal, the transfer function is  

nn
nn

mm
mm

x
aSaSaSa

bSbSbSb

SX

SY
SW












1
1

10

1
1

10

...

...

)(

)(
)( .    (1.4a) 

For the disturbance,  
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Time characteristics 

Time characteristics (responses) specify dynamic behavior of dynamic elements 

(control systems) in transient modes. 

Time responses show a dynamic element or a system response to typical signals 

under zero initial conditions. There are two time characteristics: unit step response h(t) 

and unit impulse response w(t). 

Unit step response (Heaviside response) or transient characteristic h(t) is the 

dynamic element (a control system) response to unit step input (Heaviside step func-

tion):  
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Expression for h(t) can be found with the following formula 
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where R(0) and Q(0) are, correspondingly, values of the numerator and denomi-

nator of the transfer function W(S) at S=0; 

Si is the i-th root of the characteristic equation 
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R(Si) and Q’(Si) are, correspondingly, values of the numerator and 1
st
 derivative 

of the denominator of the transfer function W(S) at S=Si. 

 

Impulse response (Dirac response) or weight function w(t) is the dynamic el-

ement (the control system) response to unit impulse input (Dirac delta function): 
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Dirac delta function is a unit impulse of an infinitely short duration, infinitely big 

magnitude, and unity square: 
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Dirac delta function can be specified as the derivative of Heaviside step function 

dt

td
t

)(1
)(  , and therefore, Dirac response (weight function) can be determined as the 

derivative of Heaviside response (transient characteristic): 
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Frequency characteristics 

Frequency characteristics describe parameters (magnitude and phase) of the 

harmonic output of a dynamic element (control system)  )(sin)()(  tAty out  

as function of frequency of harmonic input  ttx  sin1)( . 

Amplitude phase frequency characteristic is the hodograph of the vector of 

complex transfer function W(j) of a dynamic element (control system) in the steady-

state mode: 
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Complex transfer function W(j) can be obtained by substituting (j) instead of S 

into the transfer function W(S) (see expression (1.4a)): 
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Expression (1.11) is a complex number and can be reduced to real and imaginary 

components 

)Im()Re()(  jjW     (1.12) 

Amplitude phase frequency characteristic is plotted on the complex plane with Re 

(real) and Im (imaginary) axes. 

Real frequency characteristic Re() and imaginary frequency characteristic 

Im() are dependences of, correspondingly, real and imaginary components of complex 

transfer function W(j) on frequency of harmonic input signal 

 )(cos)()Re(  outA     (1.13a) 

 )(sin)()Im(  outA     (1.13b) 

Expressions for these characteristics can be found after presenting complex trans-

fer function W(j) (1.11) as a complex number with real and imaginary components. 

Amplitude frequency characteristic A() is frequency dependence of the com-

plex transfer function modulus:  
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Amplitude frequency response shows change in the amplitude ratio of the dynam-

ic element (control system) output and input with frequency.  

Phase frequency characteristic () is frequency dependence of the complex 

transfer function argument of a dynamic element (control system) in the steady-state 

mode:  
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Phase frequency response shows change in the phase angle between the dynamic 

element (control system) output and input with frequency.  

Logarithmic characteristic, or Bode diagram, comprises two plots, logarithmic 

magnitude plot in dB and logarithmic phase plot in degrees. In both plots, x-axis repre-

sents angular frequency (logarithmic scale).  



 5 

Logarithmic magnitude plot is 

)](lg[20)(  AL                                  (1.16) 

 

1.3 Typical dynamic elements of zero- and first-order 

TDEs of zero- and first-order include proportional (P), integrating (I), differentiat-

ing (D), and first-order aperiodic (A-I) dynamic elements.  

Mathematical description of these TDEs is given in tables 1.1 and 1.2. 

 

Table 1.1 – O.d.e. and transfer functions of zero- and first-order TDEs  

TDE o.d.e. Transfer function W(S) 

P y(t)=Kx(t) W(S)P=K 
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Table 1.2–Time responses and complex transfer functions of 0- and 1
st
-order TDEs  

TDE h(t) w(t) W(j) 
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1.4. Simulink model for studying typical zero- and first-order dynamic elements  

1.4. 1. Building of a Simulink model 

A Simulink model is built in “model” window by dragging required blocks from 

corresponding block libraries in Simulink Library Browser to the model window.  

Time characteristics are obtained by applying relevant signals to the dynamic el-

ement studied. Frequency characteristics are plotted with MatLab commands. 

The Simulink model for proportional (P), integrating (I), differentiating (D), and 

first-order aperiodic (A-I) dynamic elements is shown in fig. 1. The model in the figure 

is given in the general form. In the definite model built by a student, values of transfer 

coefficient K and time constant T must be taken according to the variant (table 1.7). 
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Figure 1.1 – Simulink model for studying typical dynamic elements of zero and 

first order 

 

1.4 2. Adjustment of the simulation parameters  

Before starting simulation, it is necessary to perform general adjustment of the 

simulation parameters in Configuration parameters window (fig. 1.2–1.3) and set the 

required parameters of the model blocks in Block parameter window of every block.  
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Figure 1.2 – Entry to the simulation parameter adjustment 

 

 

Figure 1.3 - Configuration parameters window with default settings 

 

In fig. 1.3, Start time field sets the start time of simulation, it is typically 0.  

Stop time field sets the stop time of simulation and specifies the simulation dura-

tion that must be long enough to show the transient in the studied dynamic element for 

every input. For P, I, and D elements with no transient, stop time can be Stop time = 2. 

For A-I element, Stop time is determined by the end of transient and start of steady-

state mode. Usually, it is equal to (3 – 4)T, where T is time constant of the element stud-

ied. 
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For sine input, the stop time is chosen so as to show two or three periods of the 

simulated signal. For sine frequency  = 1, stop time tend = 4*/1 (two periods). 

In Solver field, a numerical technique for solving differential equations is chosen. 

The default settings are shown in fig. 1.3.  

To obtain the required characteristics, it is necessary to change the settings ac-

cording to fig. 1.4:  

– to select Fixed-step from the list in Type field;  

– to set size of the fixed step dt1 in Fixed step size field not exceeding 0,01Т;  

– to select ode4 (Runge-Kutta) from the list in Solver field  

 

 

Figure 1.4 - Configuration parameters window after configuration parameter 

adjustment (parameters Tend and dt1 must be set numerically) 

 

1.5 Setting of the model blocks parameters  

1.5.1 Blocks for simulating input signals  

Blocks for simulating input signals are taken from Sources library. 

1.5.1.1 Step block is used to simulate unit step (Heaviside step function) 

x(t) = 1(t) and unit impulse (Dirac delta function) x(t) = (t).  

The block parameters to set are the following: 

Step time field specifies the time of step (default setting is 1)  

Initial value field enters the initial value of the step (default setting is 0)  
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Final value field specifies the final value of the step (default setting is 1). 

In the laboratory work, these parameters are set depending on the input signal 

type. 

To obtain step response h(t), the settings in these fields in Step block in the model 

(see fig. 1.1) must be changes according to fig. 1.5. 

 

 

Figure 1.5 – Required settings of Step parameters to obtain unit step response  

 

To obtain unit impulse response w(t), two Step blocks are connected with Sum 

block (Step1 and Step 2 blocks in fig. 1.1). The parameters of these blocks are given in 

table 1.3. 

 

Table 1.3 – Parameters of Step 1 and Step 2 blocks 

Parameter Step1 block Step2 block 

Step time 0.001 0.002 

Initial value 0 0 

Final value 1000 1000 

 

1.5.1.2 Sine Wave block is used to simulate harmonic input x(t) =Ainsint.  

The block parameters to set are the following (fig. 1.7): 
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Amplitude field specified the sine wave magnitude Ain (default setting is 1). 

Frequency field specifies the sine wave frequency  (default setting is 1). 

In the laboratory work, the magnitude of the harmonic input Ain = 1 so Ampli-

tude field remains unchanged in all four blocks Sine Wave used in the model (see 

fig. 1.1), while Frequency field changes according to the variant values of sine wave 

frequency given in table 1.7.  

Other fields in Source Block Parameters: Sine Wave window remain with de-

fault settings. 

 

 

Figure 1.6 - Source Block Parameters: Sine Wave window  

(parameter w1 must be set numerically for each Sine Wave block  

according to frequency specified in the variant) 

 

1.5.2 Blocks for visualization of output signals 

Blocks for visualization of output signals are taken from Sinks library. 

1.5.2.1 Scope block represents an oscillograph. Double click on the block opens 

the oscillograph screen window. To view the signals plotted, it may be necessary to 

press “binoculars” icon. 
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1.5.2.2 To Workspace block is used to withdraw simulation results from Sim-

ulink to Matlab to process them. The setting of the block parameters is shown in 

fig. 1.7. 

In Variable name field, the name of the variable withdrawn is entered. Letter y 

designates output variable, letter t – time. 

In Save format field, Array must be selected from the list.  

 

Figure 1.7 – Settings of To Workspace block parameters 

 

1.5.3 Blocks for simulating TDE 

1.5.3.1 Gain block located in Math Operations library represents a numerical coeffi-

cient. 

1.5.3.2 Integrator and Derivative blocks execute, correspondingly, integration and 

differentiation of an input signal. These blocks are located in Continuous library and have 

no parameters to adjust (in this laboratory work). A numerical coefficient is added with Gain 

block connected in series. 

1.5.3.3 Transfer Fcn block 

Transfer Fcn block parameters are set by entering corresponding values of polyno-

mial coefficients in the numerator and denominator of the transfer function simulated, the 

values separated with a space. In the square brackets on the right, the coefficient at S
0
 is 

placed, the order of S increasing from the right to the left. 
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Figure 1.8 presents an example of setting block Transfer Fcn parameters for a trans-

fer function of an A-I typical dynamic element  
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Figure 1.8 – Setting of block Transfer Fcn parameters for the considered example 

 

1.6. Simulation and processing of simulation results  

1.6.1 Simulation start 

The simulation is launched with command Simulation→Start simulation or by 

clicking on Start simulation icon (black triangular) in the model window (fig. 1.9). It is 

also possible to enter command sim(MyFile) in Matlab Command Window, where 

MyFile is the name of the model file, for example sim('lab1_5_int_2009b.mdl'). 

 

 

Figure 1.9 – Simulation start 
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After simulation stops, open block Scope window with a left double click to see 

the graphs. In case the curves obtained are distorted, the configuration parameters must 

be corrected (for example, fixed step size should be made smaller) and the simulation 

repeated.  

1.6.2 Simulation graph plotting  

To plot graphs of the input and output signal simulated, command plot(t,yi),grid, 

where i is 1 – for P-TDE, 2 – for I-TDE, 3 – for D-TDE, and 4 – for A-I-TDE, must be 

entered in Matlab Command Window.  

In Figure window that opens, the graphs must be edited with the help of com-

mand Edit of the top menu. It is necessary:  

– to set relevant axes limits to display the graphs distinctly with command Ed-

it→Axes Properties→Limits;  

–to click on each graph and edit the graph line with command Edit→Current 

Object Properties→Style: Solid line for the output signal and Dashed line for the in-

put signal; in Line width field to select 2.0, and in Line color to select Black for both 

lines.  

1.6.3 Building of frequency characteristics 

Frequency characteristics are built with application of the transfer functions of the 

typical dynamic elements studied. Table 1.4 presents commands that are entered in 

Matlab Command Window to obtain frequency characteristics.  

 

Table 1.4 – Commands entered in Matlab Command Window 

Frequency characteristics Commands 

Amplitude-phase frequency characteristic )( jW  plot(real(q),imag(q)),grid 

Real frequency characteristic )Re(  plot(w,real(q)),grid 

Imaginary frequency characteristic )Im(  plot(w,imag(q)),grid 

Amplitude frequency characteristic )(A  plot(w,abs(q)),grid 

Bode magnitude and phase plot )(L , )(  bode([K],[a0 a1]) 

 

Table 1.5 presents examples of commands in Matlab Command Window for 

obtaining frequency characteristics of each TDE studied in the work with transfer coef-

ficient K=2 and time constant T=0.1.  
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Table 1.5 – Examples of commands for obtaining frequency characteristics 

Typical dynamic ele-

ment 

Transfer function Commands entered  

in Matlab Command Window 

Proportional 

P-TDE 
2)( sW  

w=0:0.1:200; 

p=j*w; 

q=2.; 

plot(real(q),imag(q)),grid 

plot(w,real(q)),grid 

plot(w,imag(q)),grid 

plot(w,abs(q)),grid 

bode([2],[1]),grid 

Integrating 

I-TDE s
sW

1.0

2
)(   

w=0.001:0.01:200; 

p=j*w; 

q=2./(0.1.*p+0); 

plot(real(q),imag(q)),grid 

plot(w,real(q)),grid 

plot(w,imag(q)),grid 

plot(w,abs(q)),grid 

bode([2],[0.1 0]),grid 

Differentiating 

D-TDE 
ssW 1.02)(   

w=0:0.1:200; 

p=j*w; 

q=2.*0.1.*p; 

plot(real(q),imag(q)),grid 

plot(w,real(q)),grid 

plot(w,imag(q)),grid 

plot(w,abs(q)),grid 

bode([2*0.1 0],[1]),grid 

Aperiodic 

A-I-TDE 11.0

2
)(




s
sW  

w=0:0.01:2000; 

p=j*w; 

q=2./(0.1.*p+1); 

plot(real(q),imag(q)),grid 

plot(w,real(q)),grid 

plot(w,imag(q)),grid 

plot(w,abs(q)),grid 

bode([2],[0.1 1]),grid 

freqs([2],[0.1 1]),grid; 

 

1.7 Preparation of the report on the laboratory work 

The report on the laboratory work must be prepared in MS Word document.  

The report must contain the Simulink model of the typical dynamic elements stud-

ied and all the graphs obtained via simulation and built via Matlab commands.  

Each dynamic element studued must be mathematically described with the corre-



 15 

sponding differential and algebraic (if possible) equations and transfer function (numeri-

cal expressions with parameters K and T according to the variant). All the graphs (signals) 

must be described with the appropriate mathematical expression. 

The Simulink model is copied from Simulink with command Edit→Copy model 

to clipboard in the model window and pasted into the to the MS Word document with 

Edit→Paste command.  

The graphs are copied with command Edit→Copy Figure in the Matlab Figure 

window and pasted into the MS Word document with Edit→Paste command.It is also 

possible to save figures as files to further insert them as pictures from the files. 

For every TDE, the preferable arrangement of the graphs in the report studied is 

shown in table. 1.6  

 

Table 1.6 – Arrangement of the graphs for each dynamic element in the report 

Name of the typical dynamic link 

Mathematical description 

Unit step response Unit impulse response 

Sine wave 1 response Sine wave 2 response 

Sine wave 3 response Sine wave 4 response 

Amplitude-phase frequency characteris-

tic )( jW  

Real frequency characteristic )Re(  

Imaginary frequency characteristic 

)Im(  
Amplitude frequency characteristic )(A  

Bode magnitude and phase plot )(L , )(  

 

1.8 Assignment 

Build a Simulink model (see fig. 1.1) for studying zero- and first-order typical dy-

namic elements with the numerical parameters specified in the variant given in ta-

ble 1.7. 

Make simulation and obtain TDEs time and frequency characteristics.  

Describe with studied dynamic elements and their characteristics numerically with 

the help of formulae (1.11)-(1.16) and expressions given in tables 1.1-1.2.  

Identify the signals (which is the input and which is the output) in the figures with 

two curves. 
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Table 1.7 – Variants of the initial data  

№ K T 1 2 3 4 

1.  2 0,04 1 5 15 90 

2.  1,5 0,3 1 10 40 100 

3.  0,5 0,01 1 4 20 80 

4.  3 0,06 1 2 10 75 

5.  0,5 0,02 1 15 75 150 

6.  2,5 0,05 1 5 30 120 

7.  0,25 0,5 1 3 15 90 

8.  4 0,2 1 20 50 100 

9.  0,75 0,01 1 5 25 150 

10.  3,5 0,7 1 6 30 120 
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Appendix 

Basic characteristics of zero- and first-order TDEs in general form 

 

 

Proportional TDE 

Dynamic equation )()( tkxty   

Transfer function kSW )(  

 

 
a      b 

Figure 1.10 – Time characteristics of P-TDE 

a – unit step response (transient function) )(1)( tkth  ,  

b – unit impulse response (weight function) )(
)(

)( tk
dt

tdh
tw   

 

                           Im 

Re 

k 

Figure 1.11 – Amplitude-phase characteristic of P-TDE  
0)()()( jj ekeAjW    or W(j)=k + j0 
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Figure 1.12 – Bode plot of P-TDE:  

bode magnitude plot L()=20lgA() =20lgk;  

bode phase plot ()=0) 

 

 

 

Integrating TDE 

Dynamic equation )(tkx
dt

dy
  

Transfer function 
S

k
SW )(  

 

 

 
a      b 

Figure 1.13 – Time characteristics of I-TDE 

a – unit step response (transient function) tkth )( ,  

b – unit impulse response (weight function) k
dt

tdh
tw 

)(
)(  
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Figure 1.14 – Amplitude-phase characteristic of I-TDE  

2)()()(
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Figure 1.15 – Bode plot of I-TDE:  

bode magnitude plot L()=20lgA() =20lgk/;  

bode phase plot ()=-/2) 
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(Ideal) Differentiating TDE 

Dynamic equation 
dt

dx
Tty )(  

Transfer function STSW )(  

 

         
a      b 

Figure 1.16– Time characteristics of D-TDE 

a – unit step response (transient function) )()( tTth  ,  

b – unit impulse response (weight function) 









0,

0,0)(
)(

t

t
T

dt

tdh
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Im 

Re 

Figure 1.17 – Amplitude-phase characteristic of D-TDE  
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Figure 1.18 – Bode plot of D-TDE:  

bode magnitude plot L()=20lgA() =20lgT;  

bode phase plot ()=/2) 

 

 

First-order aperiodic TDE 

Dynamic equation )()(
)(

tkxty
dt

tdy
T   

Transfer function 
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


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k
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a       b 

Figure 1.19 – Time characteristics of A-I-TDE 

a – unit step response (transient function) 




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b – unit impulse response (weight function) T
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Figure 1.20 – Amplitude-phase characteristic of A-I-TDE  
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Figure 1.21 – Bode plot of A-I-TDE:  

bode magnitude plot L()=20lgA() =














 1)(
lg20

2T

k
;  

bode phase plot ()=arctg(-T)) 

 

 

Link to the site with tutorial on Control Systems that may help 

https://www.tutorialspoint.com/control_systems/index.htm     

https://www.tutorialspoint.com/control_systems/index.htm

